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In this Issue 

Advice from Snopes 

1) Almost all E-Mails that ask you to add your name and forward on to 

others are similar to that mass letter years ago that asked people to 

send business cards to the little kid in Florida who wanted to break 

the Guinness Book of Records for the most cards. All it was, and all 

any of this type of E-Mail is, is a way to get names and 'cookie' track-

ing information for telemarketers and spammers - - to validate active 

E-Mail accounts for their own purposes.  

2) Any time you see an E-Mail that says forward this on to '10' of your 

friends sign this petition, or you'll get bad luck, or whatever, it has ei-

ther an E-Mail tracker program attached that tracks the cookies and  

E-Mails of those folks you forward. The host sender is getting a copy 

each time it gets forwarded and then is able to get lists of 'active'       

E-Mails to use in SPAM E-Mails, or sell to others that do.  

You can do your friends and family members a GREAT favor by send-

ing this information to them; you will be providing a service to your 

friends, and will be rewarded by not getting thousands of spam E-

Mails in the future!  

If you have been sending out (FORWARDING) the above kinds of     

E-Mail, now you know why you get so much SPAM! Do yourself a   

favor and STOP adding your name (s) to those type listings regard-

less how inviting they might sound!  

You think you are supporting a GREAT cause, but you are NOT in the 

long run. Instead, you will be getting tons of junk mail later in life!  

Also: E-Mail petitions are NOT acceptable to Congress or any other 

organization. To be acceptable, petitions must have a signed signa-

ture and full address of the   person signing the petition.  

Read the full story. 

http://www.snopes.com/inboxer/petition/internet.asp 
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How to Control the Display of Your Laptop                 By Dave Bytes                                                             

http://www.davebytes.com 
You can control the way Windows looks as well as how your laptop's monitor is configured.       
To do this, you need to visit the Personalization icon in the Windows Vista Control Panel or the 
Display icon in the Windows XP Control Panel. Oddly enough, the same icon is used in both   
versions of Windows. 
 Display Settings is where you go to set up the laptop for giving a presentation.  As shown in the 
figure, it's where you configure the projector, which is treated like a second monitor. The quickest 
and handiest way to get to the Personalization or Display Properties dialog box is to right-click a 
blank part of the desktop and choose Properties from the pop-up menu.                                                                                                                          
Your laptop's display has certain modes and resolutions that work best — for example, 800 x 600 
or 1024 x 768. These and other resolutions are known as the native settings for the monitor.    
Although other resolutions might be possible, the results don't look good and can wreak havoc on 
the display. 

You might consider setting a lower resolution and number of colors for your monitor. The higher 
resolution and color settings require more video memory, which means more work for the com-
puter, more power, and less battery life. 
 

        _____     _____     _____     _____     _____     _____ 

 

What resolution should I make my pictures to use in a 

PowerPoint slide show? From: MS Office PP Help 
If you've asked this question and gotten answers like "Just scan your images at 96 dpi," I'll have 
to ask you to push your brain's Restart button. You need to clear your head of all that dpi stuff 
because for PowerPoint purposes, it's wrong, irrelevant, confusing (choose any three). 

Working out the right size for images in PowerPoint is a lot simpler than some people try to make 
it sound. The Basic Rule is this: For images that fill the slide, the image size (in pixels) should be 
equal to the video screen's resolution. 

For example, if your screen resolution is set to 1024 × 768, that's the size you want your full-slide 
images to be. If the image occupies only half the width and half the height of the slide, it should 
be 1024/2 or 512 pixels wide, and 768/2 or 384 pixels high. 

Highly detailed images sometimes look better if they're set at a bit higher resolution than The 
Rule demands. So if you're working with maps or images of text, try the same image at several 
resolutions—you'll quickly get a feel for what works best. Just don't go overboard; the higher the 
resolution, the larger the image files; the larger the image files, the larger your PowerPoint files 
will become, and the slower the images will display. You want your images to be just big enough 
to look good and not a pixel bigger. 

 

http://www.davebytes.com
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Power Point display adjusted 
 

You have a laptop with a wide-screen display. When you start a PowerPoint slide show, it doesn't fill 
the screen. Instead, it leaves black on either side. Or maybe it fills the screen but distorts the pic-
tures on your slides. Can't it fill the screen instead without making messes? 

Solution 

Yes, it can. PowerPoint will display your slides as large as it can without cropping. If the proportions 
of the slide don't match the screen then it can't fill the full screen, so it fills in the rest with black. 

If you want PowerPoint to completely fill the screen with your slides you simply have to make your 
slides the same proportion as the screen. Start by making a copy of your presentation to work on, 
then do this (assuming a wider-than-average screen): Choose File, Page Setup.                                                                                                                                                                                   
Increase Slide width; the ratio Slide width / Slide height should be the same as Screen width / 
Screen height 

How big should you make the page? 

PowerPoint MVP Austin Myers has a free program that figures this out for you 

To calculate the value yourself, you need to know the width and height of your screen in pixels. To 
get this: 

· Right-click the Windows desktop                                                                                                                                                                          
Choose Properties from the pop-up menu.                                                                                                                                                              
Click the Settings tab of the Display Properties dialog box                                                                                                                                  
Under "Screen area" you'll see the current setting as Screenwidth x Screenheight in pixels                                                                            
Make a note of the values there, then click OK to close the dialog box 

(On Mac, use System Preferences, Displays to get the current display Resolution setting) 

Now use this formula to get the correct value for your PowerPoint Slide width: 

Slidewidth = (Screenwidth x Slideheight) / Screenheight 

In other words: 

· Start with Screenwidth and Screenheight (in pixels, from Display Properties) and Slide height 
(from PowerPoint's File, Page Setup dialog box)                                                                                                                                                                                                                            
Multiply Screenwidth by Slide height                                                                                                                                                                       
Divide the result by Screenheight 

· That's the value to use for Slide width in the Page Setup dialog box 

Note: As Keith Ratner of SkillzDesign pointed out on the PPT newsgroup recently, keep your slide 
width at 10" and the height proportional to your intended screen size so you can print to normal let-
ter/A4 size paper without having to remember to checkmark "Fit to page" every time you print. 

What if the presentation's already done - and set up for a normal 4:3 ratio screen. 

You have a bit more work cut out for you. 

                                                                                                                                                                      

                                                                                                                          Continued on the next page
                                     

http://playsforcertain.com/
http://skillzdesign.com/blog/
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        Open the presentation (we'll call it O for Original) and save it to a new name (we'll use W for 
Wide). Calculate the slide size you need to use and change W's File, Page Setup, Slide Size 
to match. The graphics may become distorted; Don't worry, we'll fix that in the next few steps.                                                                                                                                                      
Open O again so that you have both presentations open at once.                                                                                                                         
Use the Window menu options in PowerPoint to arrange both presentations side by side. 

 Now step through both presentations a slide at a time. When you find a graphic that's been 
distorted in W, delete it, then select it in O and copy/paste it into W. You may want to do the 
same with text boxes, or perhaps to the text placeholders on the slide master.  

You'll probably have to make a few other tweaks to the layout, but on the whole, this should get you 
there with minimal stress. 

 

PPT 2003: Use the MS Script Editor to reset the size 

 
This works in PowerPoint 2003 (and probably 2002 and 2000). See below for a similar solution for 
2007. 

Choose Tools, Macro, Microsoft Script Editor 

In the pane on the right, double-click pres.xml 

Near the beginning of pres.xml, you'll find a line something like this: 

<p:presentation sizeof="screen" gridspacingx="49152" gridspacingy="49152"> 

Change it to this: 

<p:presentation sizeof="custom" slidesizex="7680" slidesizey="4320"  

gridspacingx="49152"   gridspacingy="49152"> 

When you switch back to PowerPoint from the Script Editor, you'll see a toolbar that has "Refresh" 
and "Do not Refresh" buttons. Click Refresh. 

Your presentation will be reset to 13.33 x 7.5 inches (or 16x9 format). The original contents of the 
slide will be on the left side of the screen, but nothing will be distorted. Select and recenter every-
thing on the slide and you're good to go. 

To choose different dimensions, multiply the dimension (in inches) you want by 576. 

Enter the results in slidesizex= (for the width) and slidesizey= (for the height). 
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Using a Full Screen Picture as a Background in PowerPoint                                                       
www.epson.com  

Some presentations benefit from using a photograph or single graphic as a background image. 

There are many ways to do this in PowerPoint, but the easiest way is listed here. 

To use a full screen picture as a background:   

1. Open a PowerPoint presentation.  

2. On the View menu, select Master > Slide Master. 

3. On the Format menu, select Background. 

4. Click the down arrow on the color bar. 

5. Select Fill Effects > Picture > Select Picture. 

6. Locate the image you want to choose and click OK.  

7. Click OK again.  

8. Click Apply to All. 

PowerPoint automatically scales the image to fit the screen. This is a wonderful way to integrate a 

graphic element into a presentation. However, because PowerPoint automatically sizes the graphic, 

the clarity of the graphic is impacted by its original size. So, a graphic that is originally 1" x 1" may 

become unrecognizable as PowerPoint resizes it. Consequently, it is best to use images that are 

relatively close in size to the final slide size. 

                         _____     _____     _____     _____     _____     _____     _____ 

Tip: 

The running processes in XP Task Manager are 

23-30 Processes - Fairly Clean Installation of Windows XP with few extras 

30-40 Processes - XP Computer with several extras such as Printer, Scanner and CD or DVD writer 

40-55 Processes - is usually too many or an indication that you have too many programs running in the background 

such as AOL, Instant Messenger or other programs. This may affect the performance of your computer 

55+ Processes - Too many for most installations, but again depends on your exact system and installed hardware 

and software. 

 

http://www.epson.com
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           Antivirus up to date? 

            Firewall? 

            Windows up to date? 

            Spy Ware? 

            See how to protect your computer at: 

                   http://gtbpcug.org/protect/ 

 

                                                        More about Internet Threats 

               Is Your Internet Security up to Date? 

Is iCloud safe?                                                          http://www.komando.com 

Q. Hi Kim. I have a question about iCloud. Is it safe to use? I joined Audible and will be downloading 

audio books. I want to put these in iCloud so I can listen to them on all my gadgets. However, I hear 

iCloud opens the door to hacking, stolen passwords and viruses. Is this true?                                

Thank you for the show and all the information you give. 

A. Thanks for the question, Shirley, and for tuning in to the show. I'm sure you'll get many hours of 

enjoyment out of your Audible membership. 

For those who don't know, Audible is an Amazon-owned service that provides access to audio books 

for a set monthly free. Titles are downloaded with a Wi-Fi connection to the listening gadget of your 

choice. 

iCloud, on the other hand, is Apple's online storage system for music, photos and documents.          

It allows you to share and synchronize your information across your computers and iOS gadgets. 

Neither one is any more dangerous than any other online service. The same rules for staying safe 

apply. 

Before I go into that, I should point that you don't need to use iCloud for your Audible files. Audible 

provides its own delivery system. 

There's an Audible app for iOS and Android gadgets. Amazon's Kindle and other e-readers have  

Audible apps you can download. 

Any computer can play an Audible file like a regular sound file. iTunes can import  

Audible files for transfer to a portable media player or to burn to a CD. 

                                                                                                                                                                                              

                                                                                                                                                                                                Continued on the next page  

http://gtbpcug.org/protect/
http://www.komando.com
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iCloud can back up your Audible files, along with the rest of your iTunes library, but you can also 

download replacement files from Audible. So, iCloud isn't really needed in this case. Learn some 

better ways to use iCloud. 

As I said, Audible and iCloud are no more dangerous than any other major Web service.               

So, the same rules apply for staying safe. 

It's important to use a strong, unique password for every account you have online, including Audible 

and iCloud. You read almost every week about hackers stealing customer usernames and pass-

words from sites. 

Crooks use that information to go after the customers' other accounts, knowing that most people use 

just one password for them all. I tell you how to make strong but memorable passwords in this tip. 

Make sure to turn on your iPhone or iPad's passcode lock at Settings>>General>>Passcode Lock. 

This will prevent people from sneaking in to your iCloud, especially if your gadget has been stolen. 

Learn more about security for your gadget.Any website that requires you to log in and conduct busi-

ness does so on a secure HTTPS page. That encrypts the communication between you and the site. 

If a thief could intercept data in transit, it would be scrambled and meaningless. 

That's true of iCloud as well. Everything sent to or from iCloud is encrypted in transit.                      

All content stored in iCloud is encrypted. Click here to learn more about HTTPS. 

You're more likely to invite a hacker or virus into your computer if you don't use and regularly update 

security software. I have the free and effective programs you need in my Security Center. Opening 

email attachments you're not sure about is also asking for trouble. 

A wireless network at home that isn't encrypted and password-protected is like leaving your front 

door wide open to a thief, except it will be your passwords and personal information that gets stolen. 

I tell you how to lock down your network in this tip. 

Even in a fast-paced, digital world, people still love books. Here are a few more ways technology 

can help you connect with books. 

When money is tight, you don't have to stop enjoying audio books. This site manages a vast collec-

tion of public domain audio books.  

Reading doesn't have to be a solitary activity. At this site, you can share and discuss what you're 

reading with other book lovers.  

If you download a lot of e-books, you know how hard it can be to keep them organized.                

This tool will help you straighten up your digital bookshelves.  

 

http://calibre-ebook.com/
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Set up Windows Mail          (Former Outlook Express)                                     http://www.comando.com 

Outlook Express was a popular desktop e-mail program. But Windows Vista does not include it.  

Windows Mail has replaced Outlook Express.   

I'll tell you how to set up Windows Mail. But first, let me explain a little about desktop e-mail pro-

grams. 

To start, you'll need an e-mail account from a provider. Windows Mail does not provide an e-mail    

account for you. You'll get one from your Internet service provider, work, school or Webmail service. 

After setup, Windows Mail will download the e-mail to your computer. 

Your e-mail provider should have POP3 or IMAP access. You'll need to know the server address for 

your account. You'll also need the SMTP server information for outgoing mail.  

For example, Gmail's POP3 address is "pop.gmail.com" (minus quotes). And its STMP address is 

"smtp.gmail.com" (minus quotes). Check your provider's help section for this information.               

Or, call and ask.  

Create a new account 

In Windows Mail, click Tools>>Accounts. Click Add. Select Email Account and click Next.  

Enter your name in the field labeled "Display name." This will be in the From field of outgoing mes-

sages. Click Next. Enter your e-mail address in the "E-mail address" field. Click Next. 

Enter the server information gathered earlier. Under "Incoming e-mail server type" select POP3 or 

IMAP. Put the POP3 or IMAP address in the "Incoming mail (POP3 or IMAP) server" field. Enter the 

SMTP address in the "Outgoing e-mail server (SMTP) name" field. Click Next. 

Enter your e-mail account's log-in information. Enter your user name and password in the proper 

fields. Check the box labeled "Remember password." Click Next. Check the box labeled "Do not 

download my e-mail at this time." Click Finish. 

Server ports 

Next, you'll need to set up the server ports. These are two numbers you'll need to get from the e-mail 

provider.  

Highlight the account you've just created in the list. Click Properties. Select the Advanced tab.    

Look under Server Port Numbers. Enter the proper numbers in the "Outgoing mail (SMTP)" and 

"Incoming mail (POP3)" fields. The provider may require a secure connection. If so, check the box 

labeled "This server requires a secure connection (SSL)." Click Apply>>OK. 

You're all set up! Click the Send/Receive button to start handling your mail. 

 

http://www.comando.com
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Some things to look into... 
http://www.printwhatyoulike.com 

We all been told to stay away from Beta Version Software, which is good advice. However for the 
ones who never had any luck to print out a Web page without getting of all the unwanted stuff that 
surrounds the part you actually would like to print, there is a way to do it now. This utility lets you pin-
point exactly what you want to see on your printout. Just look at the screen shots on the site to see 
what it is all about. “Try it, you’ll like it.” 

http://www.phonespamfilter.com 

Still getting soliciting telephone calls? How would you like to call back to complain? This site lets you 
search for the number that appeared on your caller ID. However, to take full advantage of this ser-
vice, you'll need a phone system that can use their filter script, like VOIP (Voice over IP). Yahoo 
Messenger with voice, to name one of them. 

http://www.fictionaddiction.com 

For all who think there could be a tiny Ernest Hemmingway inside of you, this site will give you 
enough information to put you on the right track to get your writing started. Even something you 
have already written can be posted on that site under the " Writers Showcase." 

http://www.photosecrets.com       

If you already have taken up photography as a hobby or just want to get started, this could be the 
site to go to. For all the Do’s and Don'ts in photography, digital or otherwise. 

http://www.listofhobbies.org 

If fishing or playing golf doesn't fill up your spare time, for us retirees that is, you might want to take a 
look at this site. Explore the many links and maybe one of them just might get you in touch with a 
hobby you always wanted to do, to fill your spare time with, enjoying doing it and having fun at the 
same time. 

Sistine Chapel 

Move the mouse around and see what happens. ±  will zoom in or out. 

IE 9 and IE 10: Change the Number of Days to Keep History 

By default, Internet Explorer will keep a list pages that you visited in the History for twenty days. 

However, if you want to clean the history more frequently or if you want to keep the history longer, 

these directions will show you how to change it.  

http://www.backcountrygallery.com/wallpaper/                                                                                

Looking for different or unusual wallpaper for your PC take a look at this site, you might find what 

you are looking for. 

http://www.laplink.com/                                                                                                                    

Moving files from one PC to another, the experts think this is the way to go.                                            

http://tinyurl.com/7yq78n2                                                                                                                 

Lessons for digital photography can be found here 

http://www.printwhatyoulike.com
http://www.phonespamfilter.com
http://www.fictionaddiction.com
http://www.photosecrets.com
http://www.listofhobbies.org
http://www.vatican.va/various/cappelle/sistina_vr/index.html
http://www.tech-recipes.com/rx/19501/ie9-ie10-change-history-days/?utm_source=feedburner&utm_medium=email&utm_campaign=Feed%3A+Tech-RecipesMain+%28Tech-Recipes+Main%29
http://www.backcountrygallery.com/wallpaper/
http://www.laplink.com/
http://tinyurl.com/7yq78n2
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      Legal Notice 

      Bay Bytes, Copyright © 2012, is the official newsletter of the Greater Tampa Bay PC User Group, Inc.(GTBPCUG). The information in this newsletter is intended to help our members. 

It has come from many sources and cannot always be verified. It is recommended that you obtain professional advice from software and hard   ware distributors, manufacturers, salesmen, or 

other professionals dealing with the subjects that appear in this newsletter. Unless specifically stated otherwise, the opinions expressed in Bay Bytes articles and columns are those of the 

individual authors and do not represent an official position of, or endorsement by GTBPCUG.GTBPCUG is not affiliated with any company, vendor or equipment manufacturer. Permission 

for reproduction of Bay Bytes in whole or in part is hereby granted to other APCUG user groups for internal, non-profit use, provided credit is given to the author, GTBPCUG Bay Bytes 

along with the copyright notice. Other reproductions require the prior permission of the editor. When published, please send a copy of your newsletter to  

editor@gtbpcug.org  or mail to P.O.Box 501, Brandon, FL, 33509-0501. 

Some Material appearing in this newsletter was provided by other members of the GTBPCUG. Thank you. 

The lighter side 

A man is strolling past the mental hospital and suddenly remembers an important meeting. 

Unfortunately, his watch had stopped and he couldn't tell if he is late or not.                                

Then, he notices a patient similarly strolling about within the hospital fence. 

Calling out to the patient, the man says, "Pardon me, sir, but do you have the time"? 

The patient calls back, "One moment!" and throws himself upon the ground, pulling out a short stick 

as he does. He pushes the stick into the ground, pulls out a carpenter's level and assures himself 

that the stick is vertical. 

With a compass, the patient locates north and with a steel ruler, measures the precise length of the 

shadow cast by the stick. 

Withdrawing a slide rule from his pocket, the patient calculates rapidly, then swiftly packs up all his 

tools and turns back to the pedestrian, saying, "It is now precisely 3:29 p.m., provided today is      

August 16th, which I believe it is." 

The man can't help but be impressed by this demonstration and sets his watch accordingly. 

Before he leaves, he says to the patient, "That was really quite remarkable, but tell me, what do you 

do on a cloudy day, or at night, when the stick casts no shadow"? 

The patient holds up his wrist and says, "I suppose I'd just look at my watch." 

mailto:editor@gtbpcug.org

